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Introduction

This chapter introduces the functions and features in SimBiology™. An
introduction to these features will help you to develop a conceptual model for
working with the software and your biochemical data.

What Is SimBiology? (p. 1-2)

Features and Functions (p. 1-5)

SimBiology and SBML (p. 1-13)

SimBiology Objects (p. 1-16)

Description of this software product

Functions grouped into categories
that support systems biology tasks

Support for the Systems Biology
Markup Language (SBML)
specification and extended features
in SimBiology

Definition of the SimBiology object
structure
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What Is SimBiology?

¢ “Required Software” on page 1-3

® “Optional Software” on page 1-3

e “Related Software” on page 1-4

SimBiology is an integrated environment for modeling biological processes,
simulating the dynamic behavior of these processes, and analyzing the
model with simulation and experimental data. Biological processes include

metabolic, genetic, and signaling pathways with transform, binding, and
transport reactions.

¢ Model — Design and build models by entering reactions, species,

parameters, kinetic laws, rules, and submodels with a graphical user
interface, a block diagram editor, or using the MATLAB® Command
Window. Verify that the model can be simulated, and use the verification
results to fix any incompatibilities in the model.

Import SBML models created with SimBiology or other modeling software
that is compliant with the Systems Biology Markup Language (SBML)
standard.

Export models created with the SimBiology desktop to MATLAB and
continue your simulations and analysis with command-line functions. For
more information, see “Modeling” on page 1-10.

Simulate — Observe changes in species amounts and parameter values
over time. Convert your model to a system of differential equations and
simulate the model numerically with various differential equation solvers.
The deterministic solvers include stiff and nonstiff ordinary differential
equation (ODE) solvers. The stochastic solvers include a stochastic
simulation algorithm with implicit and explicit tau variations. Perform
multiple stochastic ensemble runs. For more information, see “Simulation”
on page 1-11.

® Analyze — Save data from a simulation and export that data to the

MATLAB workspace. Compare simulation and experimental data, perform
sensitivity analysis, parameter estimation, and search for conserved
moieties. For more information, see “Further Analysis with MATLAB”

on page 1-12.
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Required Software

To use SimBiology, you must first install the following product from The

MathWorks:

MATLAB

Optional Software

Genetic Algorithm and Direct
Search Toolbox

Optimization Toolbox

Provides a command-line interface
and an integrated software
environment. For instructions,
see the MATLAB installation
documentation for your platform.

If you have installed MATLAB
and want to check which other
MathWorks products are installed,
enter ver in the MATLAB
Command Window.

Solve optimization problems
using genetic and direct search
algorithms. If this toolbox is
installed, you can use various
genetic and direct search
algorithms for parameter
estimation in SimBiology. If

the this toolbox is not installed,
SimBiology uses the optimization
algorithms available in MATLAB.

Solve standard and large-scale
optimization problems. If
Optimization Toolbox is installed,
you can use some algorithms
included in Optimization Toolbox
for parameter estimation in
SimBiology. If Optimization
Toolbox is not installed, SimBiology
uses the optimization algorithms
available in MATLAB.
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Related Software

Bioinformatics Toolbox Read, analyze, and visualize
genomic, proteomic, and microarray
data.
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Features and Functions

SimBiology includes many features to help you model mathematically
biological processes, simulate those processes, and analyze the results.

Graphical User Interface (p. 1-6)

Customizing Desktop Views (p. 1-8)

Command-Line Interface (p. 1-9)

Data Formats and Projects (p. 1-9)

Modeling (p. 1-10)

Simulation (p. 1-11)

Further Analysis with MATLAB
(p. 1-12)

Enter reactions and kinetic data
using a familiar spreadsheet format,
or use the Diagram to work with
block representation.

Arrange the desktop according to
your preferences.

Create and simulate model objects
interactively or by using M-code
scripts.

Group related models and simulation
data together into project files.

Model metabolic, genetic, and
signaling pathways.

Select deterministic or stochastic
solvers, simulate models, save data,
and plot results. Perform multiple
stochastic ensemble runs.

Use MATLAB functions to

analyze model properties, compare
simulation data with experimental
data; perform sensitivity analysis,
parameter estimation, search for
conserved moieties, and plot results.
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Graphical User Interface

SimBiology provides access
to command-line functionality
through a graphical user interface.

The interface lets you model, simulate,
and analyze biological pathways

and reactions. Export your model

to the MATLAB workspace and
perform further analysis through the
command-line.
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The graphical user interface (SimBiology desktop) is organized with the

following set of integrated tools:

¢ Project Explorer — View projects and the organization of models, and

navigate to components and subcomponents using a hierarchical tree
view. The project branch is divided into separate model sessions. A model
session includes model and simulation branches. The model branch is
further divided into components while the simulation branch is divided into
simulation settings and simulation data.

¢ Model Objects — Enter model data using a familiar spreadsheet format,

forms, comma-separated files, or previously saved SBML models. Model
and simulate biological processes as reactions with reactants, products, and
reaction rates. Reactions include processes that transform species, and
processes such as transport, diffusion, and binding.

¢ Diagram — Enter model data using block representations for species,

reactions, and submodels. Use the Plot block to visualize simulation data
during a simulation.
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Simulation — Simulate a model with deterministic or stochastic solvers,
save simulation data, export data to the MATLAB workspace.

Plotting — Generate simulation plots, create and save custom plots

Block Library Browser — Use the basic library included in SimBiology
for blocks in the diagram. Create and store your own custom block library.

Diagram Overview — Pan through large models using the miniaturized
view of the model in this tool.

Diagram Table View — Tools like hiding, pinning, splitting, and cloning
for model layout in the Diagram and generate histogram for degree of
connectivity of species in a model.

Bookmarks — Create custom searches for object properties with specific
values within a project, save these criteria in bookmarks.

Find — Use the find feature for simple searches within a project.

Output — Shows you the results of Find, error or warnings generated
by Verify (model verification and validation), and errors or warnings
generated by Simulation.

Embedded Help — The embedded help pane is context sensitive to the
tasks you are performing while you build, simulate and analyze your
model. As you select component branches in the Project Explorer pane or
optional panes, the topics that support your current tasks appear in the
embedded help pane on the right.

The Help browser supplements the embedded help information with
detailed reference material for command-line functions; object methods
and properties; tutorials to help you get started; and more details about
modeling, simulation, and analysis.

Kinetic Law Manager — View built-in kinetic laws and define your own
kinetic laws.

Unit Manager — View built-in units or define your own units composed
from basic physical quantities.

Table Column Manager — Customize the desktop spreadsheets using the
Table Column Manager to display or hide the properties you are interested
in viewing or editing.
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® M-code capture — Convert interactive GUI actions with the SimBiology
desktop to M-code scripts, and load them into MATLAB.

Customizing Desktop Views
You can arrange the desktop layout according to your preference.

* Changing pane location — Click the title bar of a pane, drag to the
desired location, and drop. SimBiology shows you an outline of the pane
during drag and drop. If the dropped location is on top of another pane,
click the tabs at the bottom to navigate between the panes.

¢ Obtaining default layout — From the Desktop Menu, point to Desktop
Layout and select Default Layout.

* Organizing tables — You can also add or delete the properties listed in the
table columns on each pane using the Table Column Manager.

If the Table Column Manager does not appear on your SimBiology

desktop, from the Desktop menu, select Table Column Manager. The
Table Column Manager opens in the desktop, and if the context-sensitive
help pane is open the help updates with more information.

* Changing pane title bar position — SimBiology lets you open multiple
panes from the Project Explorer. Each pane has a title bar in the Project
Settings pane. You can change the location of the title bar. Right-click
the title bar and then select Alphabetize or point to Bar Position and
select the location.

Project Settings - My ProjectModel Session - untitled

J My Project I hedal Sassion edtad  w |

i X Close My Project Chrlhi
H Save é
Alphabetize

m Mowve My Project On Bar 4 i
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Command-Line Interface

All the features in SimBiology are -[a x|
accessible and executable interactively  Ffie Edt Bebug Desktop Window rHepp
- B K -
from the MATLAB Command D | | W [ cvneeonesy (]
. . Shaortcuts (2] How to Add (2] What's New
Window or programmatically =

using M-code scripts.

You can either create your models in

the SimBiology desktop and export to Reaction Object Array

the workspace or create your models Index:  Reaction:

directly in MATLAB. 1 glucose -> glucose-6-P
i -
[0 | Llj
4 Start| W@

>> modelObj = shiomodel{'Cell");
>> reactionObj = addreaction(modelObj, 'glucose ->

Functions — Use functions to create projects, manage the unit and kinetic
law libraries, and simulate models.

Methods — Methods create objects and specify object property values.

M-code capture — In the SimBiology desktop, you can record and save
your actions as an M-code script. After loading the script into MATLAB,
you can then run the script programmatically and observe what you
created interactively.

Data Formats and Projects

SimBiology creates and stores all your models in project files. Projects group
related models and simulation data into project files.

Projects — Organize projects with related models, simulation data, and
analysis results.

A project combines models, simulations, analysis, and results. Each project
is divided into one or more model sessions.

Model session — In the SimBiology desktop, a project can contain one or
more model sessions. Each model session contains a model, any included
submodels, all its configuration settings, and any saved data.
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The configuration settings include simulation settings, units, kinetic laws,
tags, notes, and annotations.

¢ Kinetic Law library — Use built-in kinetic laws or create your own
kinetic laws for defining reaction rates.

® Units library — Use built-in units or create your own units for species
and parameters.

In addition, SimBiology supports SBML Level 2 Version 1. Systems

Biology Markup Language (SBML) is becoming the standard language for
documenting and sharing mathematical models for biological systems. You
can save your models to an SBML-formatted file or read an SBML file created
with SimBiology or other modeling software. For more information, see
“SimBiology and SBML” on page 1-13.

When you save a project, the model definition is saved with the project.
However, you can independently export a SimBiology model to an SBML file.
Use this SBML file for importing your model into SBML Level 2 Version
1-compliant modeling and simulation software.

When you import an SBML file created with other software, SimBiology
translates the model definition into SimBiology objects.

Modeling

SimBiology is an environment for designing and building biochemical models.

* Model objects — A SimBiology model is a collection of interrelated
reactions and rules that transform, transport, and bind species. The model
components are species, reactions, parameters, rules, and submodels. After
creating a model object, you can add reaction objects to the model, and then
add kinetic law objects and parameter objects to the reaction object. Other
objects define simulation settings, and rules.

®* Model properties — The properties define the characteristics of an object.
For example, a reaction object includes properties for reactions, reaction
rates, and links to associated species, parameters, and kinetic laws. You
can interactively change object properties in the graphical user interface.
Use the MATLAB get and set commands to list object properties and
change their values at the command line.
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* Submodel objects — SimBiology extends the current version of SBML
by hierarchically organizing a model with submodels. A submodel can be
a group of reactions.

By partitioning your model into functional units, you can easily understand
the model and the interactions between the submodels. You also can reuse
the functional units in other modeling projects.

* Notes — SimBiology extends the usefulness of the SBML Notes property
by allowing HTML formatted text. This property lets you link to journal
articles in PDF and other formats, Web pages, databases, graphic files,
experimental data, and verbose project notes that do not fit into a text box.

Simulation
SimBiology includes both stochastic and deterministic solvers.

® Stochastic simulation — Genetic and signaling pathways often have
a small number of molecules that are simulated more accurately with
stochastic algorithms. The stochastic solvers are based on Daniel Gillespie’s
exact solution algorithm with variations for implicit and explicit tau
leaping.

Gillespie, D., (1977), “Exact Stochastic Simulation of Coupled Chemical
Reactions,” The Journal of Physical Chemistry, 8(1):2340-2361.

The implicit tau-leaping solver works optimally with large, numerically
stiff systems. When solving numerically stiff systems, this solver remains
stable for large time intervals (tau) where the explicit tau-leaping solver
might not.

While stochastic simulations might accurately reflect the actual processes
in a cell, they might not be practical for models with a large number of
reactions or higher species amounts. Metabolic and signaling transduction
pathways fall into this category. In this case, mass-action kinetics and ODE
solvers can be a reasonable approximation.

¢ Deterministic simulation — You can choose from the list of stiff and
nonstiff deterministic simulation solvers that are included with MATLAB.
These solvers are reliable and robust.

* Dimensional analysis and unit conversion — Dimensional analysis
compares the physical quantities for parameters and species in
mathematical expressions (reaction rates, algebraic rules, assignment

1-11
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rules, and rate rules) and verifies that they are in consistent dimensions.
Unit conversion scales the parameter values and species amounts to have
the same units before simulation.

Plotting simulation results — At the end of the simulation, SimBiology
plots the results in a figure window, or you can change plot settings and
replot selected species yourself. In the SimBiology desktop, insert and
configure a Plot block in the Diagram to view the results in a plot while
the simulation runs.

Simulations settings — Configuration set objects define the properties
needed for simulation. These properties include the simulation time,
absolute and relative tolerances, and controls for dimensional analysis
and unit conversion.

Further Analysis with MATLAB
SimBiology is closely integrated with MATLAB.

Getting simulation data into MATLAB — During a simulation,
SimBiology saves (logs) the values for parameters and the amounts of
species to the MATLAB workspace.

Plotting simulation data and analyzing results — Using the functions
in MATLAB, you can select and scale species for plotting.

Parameter estimation and optimization — Estimate parameters that
are unknown in the model.

Sensitivity analysis — Calculate sensitivities of species with respect to
species and parameter input factors.

Moiety conservation — Calculate a complete set of linear conservation
relations for the species in a SimBiology model.

Ensemble runs — Perform iterative simulation runs to compare and
analyze simulation results from stochastic solvers. Find the mean and
variance as a function of time.
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SimBiology and SBML

SimBiology supports SBML Level 2 Version 1. You can import from and

e

xport to SBML- compatible .sbml files.

What Is SBML? (p. 1-13) Language for mathematically
defining biological models and
reaction pathways

SBML Support in SimBiology Description of SBML features and
(p. 1-13) functions supported in SImBiology

What Is SBML?

Systems Biology Markup Language (SBML) is an information standard for
sharing, evaluating, and developing systems biology models cooperatively.

Its purpose is to provide a structure for creating models and sharing those
models among various modeling and simulation software tools. The current
specification is available on the Web at http://sbml.org/documents/.

SBML Support in SimBiology

SimBiology supports a subset of the SBML Level 2 Version 1 specification.
Unsupported features include

Compartments — Model compartments are not supported. If an imported
SBML model has a single compartment, the model is loaded as a top-level
model. If the model has multiple compartments, SimBiology returns a
warning and does not load the SBML file.

Volume — Volume is not supported and cannot be specified.

Events — Events in an SBML file are ignored when you are importing
into a project.

Piecewise kinetics — Models with piecewise kinetics are loaded in, but
SimBiology ignores the definitions for piecewise kinetics.

Function definitions — Models containing functional definitions are loaded,
but SimBiology generates a warning and ignores the function definitions.

1-13
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MATLAB incompatible variable names in UnitDefinition — Models that
have variable names incompatible with MATLAB in UnitDefinition, are
not loaded and you see an error message.

The following features in SimBiology are not supported by SBML.:

Projects — SimBiology creates and stores all your models in project files

with the .sbproj extension. You can store multiple models in one project
file.

Hierarchical models — Organize your models with hierarchies within the
model including submodels.

Kinetic Law — You can store Kinetic law information such as the kinetic
law name and an abstract kinetic law expression.

When you export a SimBiology model to an SBML file, you save the model
as an SBML-compatible .xml file. The following information is included in
this file:

Species, reactions, parameters, and rules that are defined in the model
All unit definitions in SBML-compliant form

The reaction rate equation, but not the kinetic law
Example
In SimBiology, the Michaelis-Menten equation,

Vi *SIK,, +5)

is a kinetic law stored in the kinetic law library.

Specifically, for a one-substrate enzyme-catalyzed reaction, if you assign Vm
= v, Km = Ka, and S = A, the reaction rate equation is

Va*A/(Ka + A)

Model component properties with SBML equivalents, such as Annotation,
species, and parameter unit values will be exported. Features and



SimBiology and SBML

properties specific to SimBiology, such as submodels, Tag, and Active
cannot be exported.

1-15



1-16

SimBiology Objects

SimBiology is organized as a hierarchical list of objects under one root object.

Organization of SimBiology Objects
(p. 1-17)

Model (p. 1-17)

Submodels (p. 1-18)

Reaction (p. 1-18)

Kinetic Law (p. 1-18)

Species (p. 1-20)

Parameters (p. 1-21)

Rules (p. 1-23)

Software implementation of
SimBiology objects and definitions.

Definition of the SimBiology model
object

Definition of the SimBiology
submodel object

Definition of the SimBiology reaction
object

Definition of the SimBiology kinetic
law object

Definition of the SimBiology species
object

Definition of the SimBiology
parameter object

Definition of the SimBiology rule
object
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Organization of SimBiology Objects

This is the hierarchical organization of SimBiology objects:

Model
Species
Parameters
Reaction
Kinetic Law
Parameters
Rules
Submodel
Species
Parameters
Reaction
Kinetic Law
Parameters
Submodel

Submodel

Parameters can be scoped to a kinetic law or the model.

The recommended method to store your models in SimBiology is to create
and store project files.

Model

A SimBiology model is a collection of interrelated reactions and rules that
transform, transport, and bind species. The model components are species,
reactions, parameters, rules, and submodels. After creating a model object,
you can add reaction objects to the model, and then add kinetic law objects
and parameter objects to the reaction object. Other objects define simulation
settings and rules.

Properties define the characteristics of an object. For example, a reaction
object includes properties for reactions, reaction rates, and links to associated
species, parameters, and kinetic laws. You can interactively change object
properties in the graphical user interface. Use the MATLAB get and set

1-17
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commands to list object properties and change their values at the command
line.

Submodels

A submodel is a collection of reactions and rules that make up a distinct
module in the model.

Submodels can reference parameters in the submodel and model-level
parameters in successively higher parent models. Submodels cannot, however,
reference species that are at the parent model level.

Use submodels to keep parts of your model separate. For example consider the
citric acid or Krebs cycle, which, apart from being a major generator of ATP,
is also the source of intermediates that are precursors in the biosynthesis of
key building blocks such as amino acids (proteins) and porphyrins (heme,
chlorophyll). In SimBiology, the Krebs cycle can be modeled in a top-level
model, and the porphyrin and amino acid synthesis pathways can be modeled
as two separate submodels.

Reaction

A reaction describes a transformation, transport, or binding process that
changes one or more species. Typically, the change is the amount of a species.

Creatine + ATP <-> ADP + phophocreatine

Enter a reaction in the form

glucose + 2 ADP + 2 Pi -> 2 lactic acid + 2 ATP + 2 H20

Spaces are required before and after species names and stoichiometric values.

Kinetic Law

A kinetic law provides a mechanism for applying a specific rate law to
multiple reactions. It acts as a template for the reaction rate. The kinetic
law is defined by an expression, and the species and parameter variables
used in the expression.
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The ReactionRate is the result of defining the names of parameters and
species variables in a rate law. To get ReactionRate, the species variables
and parameter variables that participate in the reaction rate should be clearly
assigned in the Project Settings-Reactions pane Kinetic Law tab.

For example, the kinetic law Henri-Michaelis-Menten is expressed in
SimBiology as

Vi *SIK,, +5)

where Vm and Km are defined as parameters and S is defined as a species. (To
see parameter and species definitions for a kinetic law, access the Kinetic
Law Manager from the Desktop menu).

By applying the kinetic law Henri-Michaelis-Menten to a reaction
A ->B

with Vm = Va and Km = Ka
and S = A

the rate equation is
Va*A/(Ka + A)

A, Va, and Ka are defined in the Kinetic Law tab.

Reaction Rate Equation

The reaction rate equation is a mathematical expression that describes the
rate at which the reactants combine to form products.

For a reaction following Mass Action kinetics,

Creatine + ATP <-> ADP + phophocreatine

the rate equation is written as

K*Creatine*ATP - Krev*phosphocreatine*ADP

1-19
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Species

A species is a chemical or entity that participates in reactions, for example,
DNA, ATP, Pi, creatine, G-Protein, or Mitogen-Activated Protein Kinase
(MAPK) . Species amounts can vary or remain constant during a simulation.

Specifying Species Names in SimBiology
SimBiology species names can have any number, letter, or character, for
example, N-acetyl-D-glucosamine. The names of species are case-sensitive.

Note the following constraints,

¢ Name cannot be left empty.

e Name cannot be the literal words null and time. Note that you could
specify species names with these words contained within the name, for
example, nullaminoacids or nullnucleotides.

¢ If you are using a species name that is not a valid MATLAB variable name,
do the following:

= Enclose the name in square brackets when writing a reaction rate
equation or a rule. For example, enclose [DNA polymerase+] within
brackets in reaction rates and rules.

= Enter the name without brackets when you are creating the species or
when you are adding the reaction. For example, enter DNA polymerase+
when specifying the name of the species or while writing the reaction.

® Name cannot be the characters i, or j, or contain ->, < >, [, or ]. The
names i and j are reserved MATLAB characters. Because expressions
in abstract kinetic laws, reaction rates, and rules are considered to be
MATLAB code, SimBiology evaluates i or j as an imaginary number and
not as the value of species i or j. For example, an expression V*S*i/K is
interpreted to have three names, V, S, and K, instead of four. Use brackets
to protect such variables.

¢ [If a variable in a reaction rate equation or rule has the same name as a
MATLAB function, SimBiology evaluates the expression as a call to the
MATLAB function. In general, when creating variable names, you should
avoid using MATLAB function names or variable names that are invalid
in MATLAB.
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If you change the Name of a species you must configure all applicable elements,
such as rules that use the species, any user-specified ReactionRate, or

the kinetic law object property SpeciesVariableNames. Use the method
setspecies to configure SpeciesVariableNames.

To update species names in the SimBiology graphical user interface, access
each appropriate pane through the Project Explorer. You can also use the
Find feature to locate the names that you want to update. The Output pane
opens with the results of Find. Double-click a result row to go to the location
of the model component.

SimBiology automatically updates species names for reactions that use
MassAction kinetic law.

Parameters

A parameter is a quantity that can change or can be constant. In SimBiology,
parameters are generally used to define rate constants.

Scope refers to the definition of a parameter at the model (global) level or
kinetic law (local) level.

If the scope of the parameter is global in the model, it can be used by any
rule, submodel, or by any reaction rate in the model. If the scope of the
parameter is at the kinetic law level, it can be used only by the kinetic law in
the reaction for which it was defined.

How SimBiology Uses Scope

For reaction rate, SimBiology hierarchically uses the value of the parameter
with scope at the kinetic law level first. If there is no such parameter at
the kinetic law level, SimBiology looks for the parameter with scope at the
model level.

If there are two parameters with the same name, one at the model level and
the other at the kinetic law level, SimBiology uses the value of the parameter
at the kinetic law level for the reaction rate. SimBiology uses the value of
the parameter at the model level for any rules or submodels that reference
the parameter.

1-21



Introduction

1-22

For more details on scope and further links to procedures on changing scope,
see Parameter and Scope in the SimBiology User’s Guide.

Specifying Parameter Names in SimBiology
Consider the following while naming parameters in SimBiology:

e Names are case-sensitive.
¢ Name cannot be empty or time.

¢ If you are using a parameter name that is not a valid MATLAB variable
name, do the following:

= Enclose the name in square brackets when writing a reaction rate
equation or a rule.

= Enter the name without brackets when you are creating the parameter.

For example, enclose [K_DNA polymerase+] within brackets in reaction
rates and rules, but, enter K DNA polymerase+ when creating a parameter.

¢ Name cannot be the characters i, or j, or contain [, or ]. The names i
and j are reserved MATLAB characters. Because expressions in abstract
kinetic laws, reaction rates, and rules are considered to be MATLAB code,
SimBiology evaluates i or j as an imaginary number and not as the value
of species i or j. For example, an expression V*S*i/K is interpreted to
have three names, V, S, and K, instead of four. Use brackets to protect
such variables.

¢ If a variable in a reaction rate equation or rule has the same name as a
MATLAB function, SimBiology evaluates the expression as a call to the
MATLAB function. In general, when creating variable names, you should

avoid using MATLAB function names or variable names that are invalid
in MATLAB.

If you change the Name of a parameter you must configure all applicable
elements, such as rules that use the parameter, any user-specified
ReactionRate, or the kinetic law object property ParameterVariableNames.
Use the method setparameter to configure ParametervVariableNames.

To update parameter names in the SimBiology graphical user interface, access
each appropriate pane through the Project Explorer. You can also use the
Find feature to locate the names that you want to update. The Output pane
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opens with the results of Find. Double-click a result row to go to the location
of the model component.

Rules

A rule is a mathematical expression that modifies a species amount or a
parameter value. There are three types of rules in SimBiology:

Algebraic — Algebraic rules are evaluated continuously during a
simulation. An algebraic rule takes the form 0 = Expression and the
rule is specified as the Expression. For example, you could write a mass
conservation expression such as species_total = speciesl + species?2
where species_total is the independent variable, write the rule as

species1 + species2 - species_total

Assignment — Assignment rules are evaluated once at the beginning of a
simulation. Assignment rules are expressed as Variable = Expression.
For example you could write an assignment rule to set the amount of
species1 to be proportional to species?2.

species1 = k/species2
(where k is a known constant with units = concentration”2)

Rate — Rate rules are evaluated continuously during a simulation. Rate
rules are determined by dvVariable/dt = Expression which is expressed
in SimBiology as Variable = Expression. For example, to define the
rate of change in the quantity of species3 (dspecies3/dt), write the rule
in SimBiology as

species3 = k * (species1 + species2)

One example case for a rate rule is when Species1 is at the boundary
of the system, but the rate of input of species1 to the system can be
determined by a rate rule.
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Note If you plan to use a parameter in a rule, remember to set the Scope
of the parameter to model. Further, if you are using an algebraic or rate
rule to vary the value of a parameter during the simulation, clear the
ConstantValue check box for the parameter in the Parameters pane,
Settings tab.
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This chapter will get you started with creating and simulating dynamic
models with SimBiology. Models follow the structure described in the Systems
Biology Markup Language (SBML Level 2 Version 1) specification, but they
include features that extend the current release of the standard.

Gene Regulation Model (p. 2-2) Description of a simple gene
regulation model with transcription,
translation, and negative feedback
to suppress transcription

Modeling Using the SimBiology Model created interactively with the
Graphical User Interface (p. 2-9) SimBiology desktop

Modeling Using the SimBiology Model created interactively with the
Diagram (p. 2-18) SimBiology diagram interface

Modeling Using the Command-Line  Model created interactively with the
Interface (p. 2-40) MATLAB command-line interface
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Gene Regulation Model

This model is an example of simple gene regulation, where the protein product
from translation controls transcription. You could create a more complex
model by adding the enzymes, coenzymes, cofactors, nucleotides, and amino
acids that are not included in this model.

Model Diagram (p. 2-2) Visualize a systems biology model
for gene regulation with different
levels of detail

Model Reactions (p. 2-3) Describe a systems biology model
for gene regulation with a series of
reaction and rate equations

Opening the Gene Regulation Model Load the gene regulation model to
in SimBiology (p. 2-6) simulate and analyze

Model Diagram

You can visualize a systems biology model with various levels of detail.

One view sketches only the major species and processes. The gene
regulation example simplifies the regulatory mechanism by not showing the
contributions of RNA polymerase and any cofactors. The protein product
from gene expression binds to a regulatory region on the DNA and represses
transcription.

DNA

+(-) ‘
@-ﬂ—( D

Protein mRNA

Another way of looking at a systems biology model is to list the reactions in a
model with the processes they represent.

DNA -> DNA + mRNA (transcription)
mRNA -> mRNA + protein (translation)
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DNA + protein -> DNA_protein (binding)
DNA_protein -> DNA + protein (unbinding)
mRNA -> null (degradation)
protein -> null (degradation)

Drawing the reaction pathways will help you to visualize the relationships
between reactions and species. In the gene regulation example, as the amount
of a protein increases, the protein forms a complex with the gene responsible
for its expression, and slows down protein production.

> 0

\— [Protein] ——» ODD

Model Reactions

Reaction equations define a systems biology model at the level of detail needed
for a software program to simulate the dynamic behavior of the model. The
following reactions for transcription, translation, binding, and degradation
describe a simple gene-regulating mechanism. For additional information
about this model, see “Gene Regulation Model” on page 2-2.

Transcription
Transcription is where RNApolymerase and cofactors bind with a DNA
molecule. The RNApolymerase then moves along the DNA and combines

nucleotides to create mRNA. A simple model of transcription shows only the
DNA and mRNA.
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=

This model simplifies the transcription and the synthesis of mRNA by using a
single reaction.

Reaction: DNA -> DNA + mRNA
Reaction rate: v = k1*DNA molecule/second
Species: DNA = 50 molecule
mRNA = 0 molecule
Parameters: k1 = 0.2 1/second

Translation

After the mRNA moves from the nucleus to the cytoplasm, it can bind with
ribosomes. The ribosomes move along the mRNA and create proteins with
the help of tRNAs bound to amino acids. A simple model of translation shows
only the mRNA and protein product.

1»

The synthesis of the protein is modeled as a single reaction.

Reaction: mRNA -> mRNA + protein
Reaction rate: v = k2*mRNA molecule/second

Species: mRNA = 0 molecule
protein = 0 molecule
Parameters: k2 = 20 1/second

Gene Repression

Transcription of DNA to mRNA is regulated by the binding of the protein
product from translation to the DNA. As more protein is produced, the DNA is
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bound with the protein more often and less time is available for transcription
with the unbound DNA.

" ()

Protein

Forward Reaction (Binding)

Reaction: DNA + protein -> DNA_protein
Reaction rate: v = k3*DNA*protein molecule/second

Species: DNA = 50 molecule
protein = 0 molecule
Parameters: k83 = 0.2 1/(molecule*second)

Notice how the units are described for the parameter k3. In the literature,
some of the common ways to display second-order rate constants are

mole! second ' or 1/mole-second . However, software evaluations of these
common ways are sometimes ambiguous.

Reverse Reaction (Unbinding)

Reaction: DNA_protein -> DNA + protein
Reaction rate: k3r*DNA_protein molecule/second
Species: DNA_protein = 0 molecule

Parameters: k3r = 1 1/second

For this tutorial, model the binding and unbinding reactions as one reversible
reaction.

Reaction: DNA + protein <-> DNA_protein
Reaction rate: v = k3*DNA*protein - k3r*DNA_protein molecule/second

Species: DNA = 50 molecule
protein = 0 molecule

Parameters: k3 = 0.2 1/(molecule*second)
k3r = 1 1/second

2-5
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Degradation

Protein and mRNA degradation are important reactions for regulating
gene expression. The steady-state level of these compounds is maintained
by a balance between synthesis and degradation reactions. Proteins are
hydrolyzed to amino acids with the help of proteases, and nucleic acids are
degraded to nucleotides.

Degradation QO
mRNA | ——— )

mRNA degradation is modeled as a transformation to the null species.

Reaction: mRNA -> null
Reaction rate: v = k4*mRNA molecule/second
Species: mRNA = 0 molecule
Parameters: k4 = 1.5 1/second

Likewise, protein degradation is also modeled as a transformation to the null
species. The species null is a predefined species name in SimBiology.

(Protein) ——>5

Reaction: protein -> null
Reaction rate: v = k5*protein molecule/second
Species: protein = 0.0 molecule
Paremeters: k5 = 1.0 1/second

Opening the Gene Regulation Model in SimBiology

A project containing the model built in gene regulation model example is
available in SimBiology. To skip the sections on model building and to learn
about simulations in SimBiology, you can access the completed model in the
SimBiology desktop by doing the following steps:

1 Open the SimBiology desktop window. In the MATLAB Command Window,
type

sbiodesktop
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The SimBiology desktop window opens with a new but empty model.

Y

File Edit Find Diagram EBlock ibrary  Simulake  Daka  Plob bvpes

Deskiop  Window  Help

=10l ]

Shortcuts

B Model Session - untitled
- SimBiology Model

Block Library Brows.. # X

Libraries «
- =
sp;ies
rea[:c:t:i]on
- [ W _>|ILI
Incked 8

Project Settings - My Project

G Refresh

e -

= Most Recent Projects

& Most Recent Models

HOBE &0 x

+ H'Documents'SimBiology\Sydneyilola.sbproj
+ H'Documents'SimBiology'\Sydney'malory.sbp
+ H'Documents'SimBiology'\Sydney'pplum.sbp
+ H'Documents'\SimBiology\Sydney'gprotein.si—

» H'Documents'\SimBiology\Sydneymalory.xm
» H'Documents'SimBiology'\Sydneyabacus.xm
+» H'Documents'\SimBiology\Sydney'pplunt.xmil
» H:'Documents'\SimBiology\Sydneyilola.xml

2 From the File menu, select Open Project.

3 In the Load SimBiology Project dialog box navigate to

matlabroot/toolbox/simbio/simbiodemos

4 Select gene_reg.sbproj, and click Open.

The project opens with two models cell and cell2. These two models
are identical except for the graphical representation of the blocks in the

Diagram.
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5 To explore the models, double-click an item in the Project Explorer, to
open individual panes.

6 See “Simulating a Model” on page 2-16 for procedures on simulating a
model in the SimBiology desktop.
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Modeling Using the SimBiology Graphical User Interface

This section shows how to mathematically model a simple gene-regulation
pathway using the SimBiology desktop. For more information about this
model, see “Gene Regulation Model” on page 2-2. For information on
building a model with the GUT’s Diagram interface, see “Modeling Using the
SimBiology Diagram” on page 2-18.

Alternatively, you can use M-code and the MATLAB command-line interface
(see “Modeling Using the Command-Line Interface” on page 2-40). A
comparison of these methods will help you understand the model objects that
MATLAB creates behind the SimBiology desktop, and how to access and edit
a model through the MATLAB Command Window.

Creating a SimBiology Model (p. 2-9) Use the SimBiology desktop to create
a structure for entering reaction and
kinetic equations

Saving Your Work as a SimBiology Save your work in the SimBiology
Project File (p. 2-11) project format

Adding Reactions to a Model (p. 2-11) Add reactions with species, reaction
rate equations, and parameter
values to your model

Verifying the Model (p. 2-15) Verify the model to check if it is
ready for simulation

Simulating a Model (p. 2-16) Simulate your model and plot the
change in amount of species over
time

Creating a SimBiology Model

A SimBiology model is a collection of objects that are structured hierarchically.
At least one model object is needed to contain all the other objects, including
reaction and submodel objects.

1 Open the SimBiology desktop window. In the MATLAB Command Window,
type

sbiodesktop
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The SimBiology desktop window opens with a new but empty model.

<} SimBi =0l x|
File Edit Find Diagram EBlock ibrary  Simulabe  Daka  Plob bvpes  Deskiop  Window  Help
Shortcuts

Project Explorer A X Project Settings - My Project
MM Project HIOHXH ’_ b4
B Model Session - untitled
G- SimBiology Model

G Refresh

= Most Recent Projects

Reactions
+ H:'Documents'SimBiology'Sydneylola.sbproj

+ H'Documents'SimBiology' Sydney'malory.sby
+ H'Documents'SimBiology' Sydney'pplum.sbp
+ H:'Documents'SimBiologe\Sydneygprotein.si—

Patameters
Rules
Subriodels :I

Block Library Brows.. # X

Libraries =
- = & Most Recent Models
species + H:'Documents'SimBiology'Sydney'malory.xm
O » H'Documents'SimBiology'\Sydneyabacus.xm
reaction + H:'DocumentsiSimBioloq Sydneypplum.xml
|7| - » H:'Documents'\SimBiology\Sydneyilola.xml
hmod
Kl | _>I_I
-
Incked 8 o | —

2 In the Project Explorer, double-click SimBiology Model to open the
SimBiology Model pane.
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. Project Settings - My Project'Model Session - untitled,SimBiology Model

| Wy Project  * || SimBiology Model = |

Settings | pescription | Contents |

Madel Mame:
Jurtitied

Source: Mewy Madel
File harme:

Last modified:  newver

Last saved: never

3 In the Model Name box, enter a name for your model and press Enter.
For example, enter cell.

Saving Your Work as a SimBiology Project File

Project is the file format that SimBiology uses to save one or more model
sessions; the file extension is .sbproj. Projects lets you save custom settings,
notes, and data associated with your models. For more information on
projects, see “Data Formats and Projects” on page 1-9.

Save your work as a project now so that you can access this file later.

1 From the File menu, select Save Project as.
The Save SimBiology Project dialog box opens.

2 Browse to the folder in which you want to save your projects, enter a name
for the project file, and then click Save.

gene_regulation.sbproj

Adding Reactions to a Model

SimBiology models are defined by connected reactions representing
transformation, binding, and transport.

1 In the Project Explorer, double-click Reactions to open the Reactions
pane.
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2 In the Enter Reaction box, enter the reactants and products, separated
by a hyphen and right angle bracket. For example, enter the following
simple reaction for transcription:

DNA -> DNA + mRNA

3 Click Add.

4 Double-click the Name box and enter a name for the reaction. For example,
enter

Transcription

5 From the KineticLaw list, select MassAction.

Marre Reaction ReactionFate
transcription DMNA, -= DMA + mRMNA k1*DNA,

6 Click the Kinetic Law tab.

2-12
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J My Project = | SimBiology Model = || Reactions = |

Project Settings - My Project,Model Session - cell' SimBiology Model', Contents'Reactions

89 Build | %un Edit | 38 Bind B4 Unbind
Enter Reaction: I A | Delete |
RET Reaction KineticLzw ReactionRate
jR Transcription Drla, = DA + mREMS | MassAction ;I

P

Settings Kinetic Law | Rate Parameters | Rate Species I Description I
KineticLaw (Mote: Changing KinsticLawy will replace any currently configured ReactionRate):

I MaszAction

KineticLaw Expression:

=l

IMass.ﬂ.ction
ReactionRate:

Specify Carrespanding Parameter Mames:

IReacf.l'onRafe hot fuily defiped. Map parameters and specles below to define.

Ediitar... |

P

Farward Rate Parameter I VI New...l

KineticLaw Species (Species defined autamatically for MassAction KineticLaw )

DA, IDNA VI

7 In the Specify Corresponding Parameter Names box, click New. The

New Parameter dialog box opens.

a Specify name of the parameter in the Name box; for Forward Rate

Parameter, enter k1.

b From the Scope list select Kinetic Law.

When you choose this option, SimBiology makes this parameter available
only to the reaction for which it was created.

In this case, it is the DNA -> DNA + mRNA reaction.

¢ Click Create.

Note that SimBiology updates ReactionRate for the reaction to show

k1*DNA.
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8

Your reaction table should resemble the following.

Marme Reaction KineticLaw: ReactionRate
Tranzcription | DRA -= DRA + mRRNA | Massfction ;I k1*DMA

Click the Rate Parameters tab. Notice that SimBiology lists k1 with a
default value of 1.0 for the parameter.

9 Double-click the Value cell and enter a new value. From the ValueUnits

10

12

list, select the units for this parameter. The rate constant k1 for
transcription is 0.2 1/second.

Your parameters table should resemble the following.

Parameters used by this reaction:
MName Scope Yalue | “aluellnits
ki ~ | DMA-> DNA -~ 02 1/second |

In the Project Explorer, double-click Species. The species you entered in
the reaction are automatically added to the species table.

The default value for a species is 0.0.

Double-click the InitialAmount cell and enter a new value. From the
InitialAmountUnits list, select the units for this species. The initial value
for the species DNA is 50 molecule and 0.0 molecule for mRNA.

Enter the remaining reactions. For a list of reactions and parameters,
see “Model Reactions” on page 2-3.

Notice that the ValueUnits for the second-order rate constant k3 is not a
default unit in the list. However, molecule and second are default units
and you can enter this unit directly by typing

1/(molecule*second)

Without the parentheses, molecule would be divided into 1, and then the
result multiplied (not divided) by second.
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Your reaction, species, and parameter panes should look similar to the

following ones.

Mame Reaction KineticLaw: ReactionFate

Transcription DA, = DRA + mRRA Massdotion ;I k1*DrA,

Translation mRMA = mRERDS + protein Wassdotion ;I k2 mRRlA,

Binding/Unbinding D& + protein =-= DM&_protein | Massiction ;I k3*DMA*protein - kK3rsDMA,_protein
mRMA Degradstion | mRMA = null Masstotion ﬂ ka*mRMA,

Protein Degradation | protein -= null Massaction ;I kS*pratein

Mame Initial&maount Initial&mourtUnits

DA, 500 molecule -

mRMA, oo molecule ;I

pratein oo malgcule ;I
Drla,_protein oo malgcule ;I

Mame Scope Yalue Yaluelnits

k1 DA -= DA + mBMNA 0z 1/zecond ;I
k2 mRMA = mRERD + protein 200 1isecand ﬂ
k3 DA, + protein =-= DA _protein 0z 1imaolecule*secand) ;I
k3r DA, + protein =-= DA _protein 1.0 1izecond ;I
ke MR, = nul 15 1/s8cond |
kS protein -= null 1.0 1/zecand =1

For more detailed information about the reactions in this model, see “Gene
Regulation Model” on page 2-2.

Verifying the Model

While you are building your model in the SimBiology desktop you can click

at any time to generate a list of any errors and warnings in the

model. The errors and warnings appear in the Qutput pane. Following is an
example of the error generated when the reaction rate of a reaction is set to a

parameter that you have not defined in SimBiology.

2-15



2 Tutorial Model

Output - Model Yerification

3 R <= null Reaction The ohject ku' in reaction 'Receptor-syrthesis
€3 =no names= =unknowen types= Errar using === simkio'grivatelodebuilder=hbuil
Kl | [
2 errors.

Use Verify to see if the example model shows any error or warnings.
Double-click the error row to move to the location of the error.

You can interrupt and stop the verification process by clicking Stop at any
time during verification.

Simulating a Model

After you enter the reactions for your model, you can simulate its dynamic
behavior and plot the results. If you have more than one model session in
your project, then you must first make the model you want to simulate
active. SimBiology shows the name of the active model in bold in the Project
Explorer. To make a model active,

1 In the Project Explorer, right-click the model.
2 Select Activate (model name).

The model name is bold in the Project Explorer indicating that this
model is the active model in the project.

To simulate a model,

1 From the simulation toolbar, in the Solver Type list, select a stochastic or
ordinary differential equation (ODE) solver. For example, select ode15s.

2 In the Stop time box, enter the length of time for the simulation. For
example, enter 10 seconds.

3 From the Simulate menu, click Start, or from the simulation toolbar,

click @ (Run).
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The simulation runs to completion and then draws the results in a figure

window. You can annotate your plot in the figure window.

=10l x|
File Edit View Insert Tools Desktop Window Help ]
Gene Regulation - ODE15s Solver
a0 . . . .
«4- DNA
40+ : .
2 «4- DNA_protein
=
2 30t -
p -4- protein
I _
2 20} P |
ab}
&
107 -
<4- mRNA
O 1 T 1 1
2 4 & g 10

Time (seconds)
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Modeling Using the SimBiology Diagram

This section shows how to model a simple gene-regulation pathway using the
SimBiology Diagram interface. For more information about this model, see

“Gene Regulation Model” on page 2-2.

Creating a SimBiology Model
(p. 2-18)

Saving Your Work as a SimBiology
Project File (p. 2-21)

Adding Reactions to a Model
Diagram (p. 2-21)

Simulating a Model (p. 2-25)

Setting Block Appearance and
Diagram Layout (p. 2-26)

Use the SimBiology Diagram to
interact with a graphical view of the
model while entering reactions and
kinetic equations

Save your work in the SimBiology
project format

Add reactions with species, reaction
rate equations, and parameter
values to your model

Simulate your model and plot the
change in amount of species over
time

Change the appearance of diagram
components and layout

Printing and Exporting the Diagram How to print the diagram

(p. 2-37)

Creating a SimBiology Model

A SimBiology model is a collection of objects that are structured hierarchically.
At least one model object is needed to contain all the other objects. The
SimBiology Diagram lets you work with the familiar graphical representation

of biological pathways and processes.

This section shows you how to build your model using block representations
for each species, reaction, and submodel. The model reactions are shown in

“Gene Regulation Model” on page 2-2.

1 Open the SimBiology desktop window. In the MATLAB Command Window,

type



Modeling Using the SimBiology Diagram

sbiodesktop

The SimBiology window opens with a new but empty model.

i

File Edit Find Diagram EBlock library Simulate Data  Flot bvpes Desktop  Window  Help
Shortcuks

Project Explorer

Project Settings - My Project

My Project HOHEHA |7 X
- Madel Session - untitled
EI SimBinlogy Model

- Diagram
I‘::'I---Contents

Species

G Refresh

> Most Recent Projects

2

Reactions
» H'Documents'SimBiology\Sydneylola.sbproj

» H'Documents'SimBiology'\Sydney'malory.sbg
» H'Documents'SimBiology'\Sydney'pplum.sbp
» H'Documents'\SimBiology'\Sydney'gprotein.st—

Parameters
Rules
Submodels j

Block Library Brows... A X

Libraries =
- - & Most Recent Models
species + H:Documents'SimBiology'Sydneyimalory.xm
O + H:'Documents'SimBiology'Sydneyabacus.xm
reaction + H:'Documents'SimBiology Sydney'pplum.xmi

|—| - + H'Documents\SimBiology\Sydneyilola.xml
bmod
4 | _*IJ

Iocked ) T | —

| [T=0

2 In the Project Explorer, double-click Diagram. SimBiology opens an
empty Diagram pane.
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-} SimBiology

=10l ]

File Edit Find Diagram EBlock ibrary  Simulabe  Daka  Plob bvpes  Deskiop  Window  Help

Shorkcuts
Project Explorer A X
My Project =

B Model Session - untitled
G- SimBiology Model
----- Diagram
E---Contents
----- Species
----- Reactions

Project Settings - My Project,Model Session - untitled",...

HOBE &0 x

Block Library Brows.. # X

| My Project = || Diagram x|

IIUU'% vl - e +

Libraries =
N e
species
reaction
| MIRNLRLY | il
K v
locked
& 4
T=0
| I y

SimBiology updates Model Session in the Project Explorer with the

new name.

3 In the Diagram pane, right-click and select Properties. In the Diagram
Properties dialog box, enter a name for your model. For example, in the
Model Name box, enter cell, and press Enter.

All the procedures in this section refer to the SimBiology desktop in the
default layout. To set the desktop to the default layout, select Desktop >
Desktop Layout > Default Layout.
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Saving Your Work as a SimBiology Project File

Project is the file format that SimBiology uses to save one or more model
sessions; the file extension is .sbproj. Projects lets you save custom settings,
notes, and data associated with your models. For more information on
projects, see “Data Formats and Projects” on page 1-9.

Save your work as a project now so that you can access this file later.

1 From the File menu, select Save Project as.
The Save SimBiology Project dialog box opens.

2 Browse to the folder in which you want to save your projects, enter a name
for the project file, and then click Save.

gene_regulation.sbproj

Adding Reactions to a Model Diagram

SimBiology models are defined by connected reactions representing
transformation, binding, and transport. You can graphically represent the
reactions in the diagram. This section shows you how to add, connect, and
configure blocks in a diagram. For this example, use the Basic library that
is shipped with SimBiology.

1 From the Block Library Browser, click and drag a Species block into
the diagram.

2 Double-click the Species block to open the Species Properties dialog box.
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I I]escriptiunl Appearance

[Matne:

Ispecies_1
Initizl Amont:
fo.0

Initigl Aot nits:

! o

[ Constant&mourt [Select if the species guartity cannot change during the simulation.)

[ EBoundaryCondition (Select if the species quantity is nat determined by the set of reactions.)

Cloze |

3 In the Name box, enter the species name. For example, enter DNA.

4 In the InitialAmount cell, enter a new value. From the
InitialAmountUnits list, select the units for this species. The initial value
for the species DNA is 50 molecule.

5 Click Close.

6 From the Block Library Browser, click and drag another Species block
into the diagram. Name this species mRNA The InitialAmount for mRNA is
the default (0.0). From the InitialAmountUnits list, select molecule as
units for this species.

7 From the Block Library Browser, click and drag a Reaction block into
the diagram.

8 Hold down the Ctrl key (Windows and Linux platforms) or the Option
key (Macintosh) while clicking the DNA Species block. Drag the line to the
reaction and release the mouse. SimBiology assigns DNA as a reactant.

Since DNA is also a product of the reaction, connect a line from the Reaction
block to DNA. SimBiology draws a dashed line, indicating that DNA is a
modifier for the reaction

9 Draw a line from the Reaction block to the mRNA Species block.

10 Double-click the Reaction block (alternatively, right-click and select
Properties) to open the Reaction Properties dialog box. Notice that the
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Reaction box shows the reaction (DNA -> mRNA + DNA) to which the block
applies.

11 Click the Name box and give the reaction a name. For example, enter
Transcription.

«) Basic: Reaction Properties X

Settingsl Kinetic Lawl Rate Parame‘tersl Rate Speciesl [Iescrip‘tinnl Appearance

Reaction:
IDNA == nRMA + DA, %

Mame:
ITrancriptic-n|

v active [Select if the reaction is enabled during the simulation.)

[ Reversible [Select if the reaction alzo ocours in the reverse direction)

Close |

12 Click the Kinetic Law tab.
13 In the Specify Corresponding Parameter Names box, click New. The
New Parameter dialog box opens

a Specify name of the parameter in the Name box; for Forward Rate
Parameter, enter k1.

b From the Scope list, select Kinetic Law.

When you choose this option, SimBiology makes this parameter available
only to the reaction for which it was created. In this case, it is the DNA
-> DNA + mRNA reaction.

¢ Click Create.

Notice that SimBiology updates ReactionRate for the reaction to show
k1*DNA.

14 Click the Rate Parameters tab. Note that SimBiology lists k1 with a
default value of 1.0 for the parameter.
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15 Double-click the Value cell and enter a new value. From the ValueUnits
list, select the units for this parameter. The rate constant k1 for

transcription is 0.2 1/second.

Your parameters table should resemble the following:

Parameters used by this reaction:
Marme Scope Yalue | “aluelnits
k1 ~| DNA-> DNA . ~ 02 1isecond |
-

16 Click Close. Your diagram should now look similar to the one below.

Project Settings - My Project,Model Session - cell’\5im...

BOAE &0 x

>

Imu% vI - e—r— + ‘
e

DhA Transcription -
RMA

4 il

17 Add the other species and reactions blocks, and create parameters for
each reaction as shown in the steps above. For a list of reactions and
parameters, see “Model Reactions” on page 2-3. Verify that the reaction

rate is determined for each reaction.
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After creating the model, the diagram should now look similar to the one
below.

-
— 2

DMA_protein T— O

“Binding/nbinifig—__

DMA Transcription mRM A Translation pl'uteinx“‘xx

Protein Degradation
mRENA Degradation

Notice the use of dashed lines for species that are both reactants and
products in a reaction (modifiers). Note the indicator for a reversible reaction
associated with the Binding/Unbinding reaction.

You can change the layout and appearance of the blocks at anytime.
Double-click a block and click the Block Appearance tab to change the color,
and text font, size and location. See “Changing Block Appearance” on page
2-27 for more information.

Simulating a Model

After you enter the reactions for your model, you can simulate its dynamic
behavior and plot the results. If you have more than one model session in
your project, then you must first make the model you want to simulate
active. SimBiology shows the name of the active model in bold in the Project
Explorer.

To make a model active,

1 In the Project Explorer, right-click the model.

2 Select Activate (model name).
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The model name is bold in the Project Explorer indicating that this
model is the active model in the project.

To simulate the model,

1 From the simulation toolbar, in the Solver Type list, select a stochastic or
ordinary differential equation (ODE) solver. For example, select ode15s.

2 In the Stop time box, enter the length of time for the simulation. For
example, enter 10 seconds.

3 From the Simulate menu, click Start, or from the simulation toolbar,

click @l (Run).

The simulation runs to completion and then draws the results in a figure
window.

_lox
File Edit View Insert Tools Desktop Window Help ]
Gene Regulation - ODE15s Solver

50 . . . .
«4- DNA
40+ } :
= <4 DNA_protein
=
E a0 .
P -4- protein
2 20} P -
i
&
107 1
<4- mRNA
O 1 I 1 1
0 2 4 6 g 10
Time (seconds)

Setting Block Appearance and Diagram Layout

This section shows you how to change the appearance and layout of a
SimBiology diagram.
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Changing Block Appearance (p. 2-27) Change the appearance of blocks,
text, lines, and indicators

Applying Block Appearance Styles How to apply a specific block

(p. 2-30) appearance style to other blocks

Changing the Diagram Layout How to manually lay out blocks in

Manually (p. 2-30) the diagram using split, clone, hide,
and pin

Changing the Diagram Layout How to automatically lay out blocks

Automatically (p. 2-33) in the diagram

How SimBiology Does Diagram How automatic layout works

Layout (p. 2-36)

Changing Block Appearance
You can change the appearance of blocks, text, lines, and indicators in the
diagram. The following figure is one example.

Binding/Unbinding
DNA_protein |—= £ DNA

I
1
1
TTranscriptinn

Translation
protein |[—-——O ===
C (B

Protein Debradatiun mRMA Deéradation

This example uses the DNA Species block and the Binding/Unbinding
Reaction block, to show you how to change the color of the blocks, the location
of the text, the appearance of the reversible indicator, and line appearance as
shown in the previous figure.

1 Double-click the Species block or the Reaction block to open the Properties
dialog box.
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2 Click the Appearance tab.

Text Location:

I bokkom LI

Texk Fonk:
| arial IR =
Block Appearance:

I oval - |
& - |Text Color {3pecify the color of the text.)

i - |Edge Color {3pecify the outline color of the block, )

& - |Face Colar (Specify the Fill calor of the Block.)

Close |

3 From the Text Location list, select where the text should be positioned in
the diagram. The default is bottom. For example:

® For the DNA Species block, select center to position the text within the
center of the Species block.

¢ For the Binding/Unbinding Reaction block, select top.
4 From the Text Font, Block Appearance, Text Color, Edge Color, and

Face Color lists, select the text font, block appearance, text color, edge
color, and block fill color.

Tip Select Face Color > No Face Color to obtain the result shown for
reaction blocks in the diagram figure above.

Tip Select Block Appearance > Image to insert an image for the block.
SimBiology opens a dialog box that lets you browse to the image location. If

[l
you change the image, click il Refresh to reload the updated image.
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5 Double-click a line to open the Line Properties dialog box. The default line
width is 1.0 pixels. The line width in the previous example diagram is 2.0.

6 In the diagram, right-click and select Properties. The Diagram Properties
dialog box opens.

7 Click the Indicators tab.

) Diagram Properties X

I Layout | Appearance |

The Follmwing are indicators that appear next to a block,
Select the checkbox if ywou want the indicator to appear,

Indicator Descripkion
Shiows indicator when a block is pinned

Shiows indicator when a species block has CaonstantAmount set ko true

Shiows indicator when a species block has BoundaryCondition set ko brue

Shows indicator when a species block is cloned

Show indicator when a reaction block has Rewversible sek to true

Show indicator when a reaction block has Active set to False ;I

Close |

8 Clear or select an indicator check box, to turn off or turn on the display of
the indicator in the diagram. For example, clear the Reversible property
indicator, and click Close.

RS

Notice that the reversible indicator is now off for the Binding/Unbinding
Reaction block in the diagram.

9 Click Layout to automatically change the layout of the diagram. You can
manually lay out the diagram using the pin, split, clone, and hide features
in the diagram.

For more information on the pin, split, clone, and hide features in the
diagram, see “Changing the Diagram Layout Manually” on page 2-30, and
for information on automatic layout in SimBiology, see “Changing the
Diagram Layout Automatically” on page 2-33.
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Applying Block Appearance Styles

To replicate the appearance style of a block to other blocks by copying and
applying the style on selected blocks:

1 Select a Species block, for example, the DNA Species block.
2 Right-click the block and select Copy Block Style.
3 Select another block, for example, the DNA protein Species block.
You can also select multiple blocks to apply the style to all selected blocks.

4 Right-click the block and select Apply Block Style. SimBiology changes
the appearance of the block to match the selected style.

Changing the Diagram Layout Manually

You can manually lay out the diagram using the pin, split, clone, and hide
features in the diagram. Use the Diagram Table View pane or a block’s
right-click context menu to change the properties discussed below. To access
Diagram Table View, from the Diagram menu, select Tools > Diagram
Table View.

Tip While you are working on the diagram layout, remember to select File >
Save Project to save the desired layout of your diagram. SimBiology saves
the layout in the project.

To manually lay out the model diagram:

1 Right-click a Species block, and select Split Block. For example, split
the protein Species block.

SimBiology provides a representation of the split block for each instance
of the species in the model. Notice that although there could be multiple
split blocks there is only one species.

If you change any settings in the Species Properties dialog box for any of
these split blocks, the change will propagate to each of the split blocks. For
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example, if you change the appearance of the block, the change affects
all split blocks.

Note You can only split Species blocks.

2 Manually move the split blocks to the desired position.

protein

1ty

Binding/Unbinding

I
DNA J:rntem
Transcnptlon

Translatlnn

-\

Protein Degradation mRMA Degradatmn

3 From the Diagram menu, select Tools > Diagram Table View to open
the Diagram Table View pane.

Marme Split Hidle:
DA,

2 [yl

il Cr2_protein
mRMA

I
=

Degree

W Protein Degradsation
" miMA, Degradation

[l Translation

=3 Transcription

| { w { f
|
|

I EindingUnkinding

Diagram Table View is a tool that lets you hide or show blocks, split or
combine blocks, and pin or unpin blocks. You can select a single block or
perform the action on multiple selected blocks. Diagram Table View also
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shows you the degree of connectivity in your diagram and also lets you view
a histogram of the degree of connectivity.

4 In the row for the protein Species block, clear the Split check box.
SimBiology combines the split blocks. Alternatively, you can right-click the
Species block and select Combine Split Blocks.

5 Select the row for the Transcription Reaction block and press
Ctrl+left-click to select the row for the mRNA Species block. Ctrl+click lets
you select discontinuous rows.

6 Right-click and select Pin Selected Blocks. SimBiology pins the blocks.
You cannot move pinned blocks manually or with automatic layout. Note
the indicator for pinned blocks in the following diagram.

2
ElindingIUnbiW

DNA_protein é
&I'Transcription
Translation 2
protein [=+——O0--- m

Protein Dégradatinn mRMA Dégradatinn

7 Select the row for the Protein Degradation reaction and press
Shift+left-click to select the row for the mRNA Degradation reaction.

8 Right-click and select Hide Selected Blocks. SimBiology hides the two
reactions in the diagram. The reaction rows are visible in the Diagram
Table View pane.

Note Hiding a block only hides it graphically. The block is still represented
in the mathematical model.

9 Select a block, right-click and select Rotate Clockwise to rotate the
selected block.
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10 Select Diagram > Show All Hidden Blocks and Lines to see all blocks.

11 Click L] st in the Diagram Table View toolbar.

SimBiology opens a figure window with a histogram of the degrees of
connectivity plotted as the number of connections versus the number of

blocks.

#of Blocks

1 2 3 4

# of Degrees

You can also see the degree of connectivity in the Degree column.

Changing the Diagram Layout Automatically
From the Diagram menu select Layout to use the automatic layout feature.
Select blocks and use the automatic layout feature to lay out only the selected

blocks in the diagram.

Automatic layout works only on blocks that are not pinned. You can right-click
and select Unpin Block if you want to lay out all blocks. Leave blocks pinned
if you do not want the position of the block to change during layout.

This example starts with the blocks for mRNA and Transcription pinned.

The default settings for automatic layout should work well for many models.
You can optionally change the automatic layout settings in SimBiology.
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To change the settings for automatic layout:

1 Right-click the diagram background and select Properties. The Diagram
Properties dialog box opens.

2 Click the Layout tab.

<} Diagram Properties x|

5ettings| Descriptinnl Enntentsl Indicators Appearance

Murmber of Layvout Iterations:
|s00

Timeouk (Maximum kime available For layout in milliseconds):
100000

Maximum Distance {Maximum distance a block can be moved in one lawout iteration:
j100.0

Line Spring Constant (How strongly the blocks repel each other):
|2.0E-5

Line Spring Length {Desired length For each line):
0.0

Repulsion Limik {Distance beyond which blocks no longer atbract each other)
J400.0

Refresh Rate {Rate the diagram is updated during layvout in milliseconds):
1000

Layout |
Close |

3 In the Number of Layout Iterations box, enter the number of iterations
to include in the layout. The default is 500. More iterations give you a
better layout, but also take more time. For example, enter 700.

4 In the Maximum Distance box, specify the distance that a block moves in
one iteration. The default is 100.0. If you enter a smaller value, layout is
slower. Large values can also cause oscillation in the layout. For example,
enter 50.

5 In the Line Spring Constant box, specify the strength with which the
lines between blocks pull blocks together. The default is 2.0E-5. Increasing
the spring constant creates more compact diagrams by increasing the
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spring attraction. For example, enter 2.0E-6 and click Layout to apply
the settings.

The layout should be similar to the following diagram.

DNA_protein

Binding/Unbinding

- @
“'--'ITranscriptinn

f =
Jd mRMNA Dégradatinn

.
Translation

Protein Degradation

6 In the Line Spring Length box, specify the length for each line. The
default is 0.0, indicating that force due to the spring is 0 at this length.
Compress this length to push the blocks further apart. For example, enter
10.

7 In the Repulsion Limit box, specify the maximum repelling distance that
limits the distance at which blocks repel each other. The default is 400.0.
Setting this to a large distance causes all blocks to repel each other. This
spreads the diagram out. A smaller value allows only nearby blocks to
repel, creating a more uniformly filled diagram. For example, enter 200.

8 In the Refresh Rate box, enter the rate (in milliseconds) at which the
diagram is updated during layout. The default is 1000. For example, enter
500.

9 In the Diagram pane, right-click the DNA Species block and select Split
Block.

10 In the Diagram Table View pane, clear the Pin check boxes for the
Transcription Reaction block and the mRNA Species block.
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11 Click Layout to apply the settings. Your diagram should resemble the
following diagram.

i
1

&i‘TranscriptiDn

DNA_protein

Binding/Unbinding

! 3]
Trans_l‘a'iinn mRMNA Degradation

Protein Dégradatiun

12 Click Close to close the Diagram Properties dialog box.

How SimBiology Does Diagram Layout

The automatic layout feature in SimBiology arranges blocks using a simple
“force directed” algorithm.

Every block is affected by three forces:

¢ Edges of the diagram repel blocks

¢ Blocks repel each other

¢ Lines between blocks act as springs that draw blocks toward each other
The algorithm tries to minimize the sum of these forces. In each iteration,
SimBiology calculates the total force on each block. SimBiology then moves

each block in the direction of and proportional to the force acting on it. Two
adjustable parameters control the dynamics of the layout:
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¢ The number of iterations that are taken determines how long the layout
takes and thereby how well it can do.

¢ The maximum distance constrains the distance that any block will be
moved in one iteration. A small value makes layout progress go slowly. A
large value may cause oscillation in the layout.

Three adjustable parameters influence the layout of the diagram:

¢ The spring constant controls how strongly the lines between blocks pull
blocks together. Increasing the spring constant creates more compact
diagrams as the spring attraction dominates the repulsion between blocks.

® The spring length controls the “natural length” of the lines between
blocks. The force due to the spring is zero at this length. When a spring is
compressed to less than this length, it pushes the blocks apart.

® The maximum repelling distance limits the distance at which blocks repel
each other. Setting this value to a large distance causes all blocks to repel
each other. This spreads the diagram out. A smaller value allows only
nearby blocks to repel, creating a more uniformly filled diagram.

Printing and Exporting the Diagram

You can annotate and print your pathway’s block diagram in SimBiology, or
you can export the diagram to .svg, . jpeg, or .pdf file formats. For example,
you can annotate the diagram with the name of the author, the date, notes,
and name of the organization. You can choose to place the content as a header
or footer on the diagram page.

Printing a Diagram

Right-click in the SimBiology diagram and select Print to open the Print
dialog box and print the diagram. By default there are no annotations.
However, if you previously annotated the diagram using Diagram Print
Setup, the printed document contains the annotations. You can access
Diagram Print Setup from the diagram’s right-click (context) menu.

To annotate and print a diagram:

1 In the SimBiology Diagram pane, right-click the background of the
diagram and select Diagram Print Setup.
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The Diagram Print Setup dialog box opens.

2 In the Diagram Options tab do the following:
a From the Diagrams to Print list, select one of the following:
® Current diagram, to print only the diagram in view (default).

® Current diagram and parent diagrams, to print the submodel
diagram currently in view along with the parent models.

® Current diagram and subdiagrams, to print diagram in view and
all its submodel diagrams.

® All diagrams in model session, to print the parent model and
all submodels in the model session regardless of the model diagram
currently in view.

b Clear the Print frame around diagram check box if you do not want a
frame in the printed document. SimBiology adds a frame by default.

¢ In the Scale box, select the size to adjust the diagram to (100% is default
size). Alternatively, click the Fit diagram to button and specify the
desired width and height.

3 Click the Page Annotation tab.

4 Click Edit. The Customize Page Annotation dialog box opens. This dialog
box lets you enter and store customized information for print annotation.

a In the relevant fields, enter the name of your organization, and your
name.

b From the Date Format and Page Format lists, select the date and
page formats respectively.

¢ Click OK

5 Place the cursor in a Header or Footer box and click Author, Company,
Model, or Date.

SimBiology inserts the information entered in the Customize Page
Annotation dialog box. Alternatively, you can type information into each

field.

6 In the Diagram Notes box, enter notes to be included.
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7 From the notes location list select whether to include notes in the printout,
and the location. You can also choose to include the notes only on the first

page.
8 Click OK to leave Diagram Print Setup.
Alternatively, click Print to open the Print dialog box and print the

diagram.

Exporting a Diagram Image

You can export the image of a pathway diagram in a portable file format
for use by other applications such as PowerPoint®. SimBiology exports the
graphical representation of the model.

1 In the SimBiology Diagram pane, right-click the background of the
diagram and select Export Current Diagram As.

The Export Current Diagram As dialog box opens.
2 From the File type list, specify the type of file to export.
3 Click ... (Browse), to choose the file location.
4 In the File name box, specify the file name.

5 Keep the default selection for the Preserve aspect ratio check box to
preserve the width and height ratio of the diagram.

6 (Optional) Specify the desired width and height of the image in inches, in
the Width and Height boxes respectively.

7 Click OK to export the file.
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Modeling Using the Command-Line Interface

2-40

This section shows how to model a simple gene-regulation pathway using
M-code and the command-line interface. For more information about this
model, see “Gene Regulation Model” on page 2-2.

You can also use a graphical user interface (see “Modeling Using the
SimBiology Graphical User Interface” on page 2-9 and “Modeling Using the
SimBiology Diagram” on page 2-18). A comparison of the three methods will
help you understand the model objects that MATLAB creates behind the
sbiodesktop, how to access and edit a model through the MATLAB Command
Window, and enable you to determine the workflow of your preference.

Creating a SimBiology Model
(p. 2-40)

Adding the Reaction for
Transcription (p. 2-42)

Adding the Reaction for Translation
(p. 2-43)

Adding the Reactions for Gene
Regulation (p. 2-43)

Adding the Reactions for mRNA and
Protein Degradation (p. 2-44)

Simulating the Model with an ODE
Solver (p. 2-44)

Simulating the Model with a
Stochastic Solver (p. 2-46)

Use the MATLAB Command Window
to create a structure for entering
reaction and kinetic equations

A DNA molecule produces multiple
copies of mRNA

Multiple copies of a protein are
produced from each mRNA molecule

The protein binds with DNA and
stops transcription

Degradation reactions balance the
synthesis reactions and maintain a
steady state

Select a deterministic numerical
solver

Select a stochastic solver that
considers the probability of the
occurrence of a reaction

Creating a SimBiology Model

A SimBiology model is a collection of objects that are structured hierarchically.
At least one model object is needed to contain all the other objects, including

reaction and submodel objects.
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1 Create a model object. For example, to create a model with the name cell,
in the MATLAB Command Window, type

Mobj = sbiomodel('cell')

MATLAB creates a model object (Mobj) in the workspace and displays a
summary of the objects in the model.

SimBiology Model - cell

Model Components:

Models:
Parameters:
Reactions:
Rules:
Species:

o O o oo

2 Display all the model object properties by typing

get(Mobj)

MATLAB displays a list of properties for the model object and their current

values.

Annotation:
Models:
Name:
Notes:
Parameters:
Parent:
Species:
Reactions:
Rules:

Tag:

Type:
UserData:

[Ox1

double]

‘cell’

[Ox1
[1x1
[Ox1
[Ox1
[Ox1

double]
SimBiology.Root]
double]
double]
double]

‘sbiomodel’

[1

Some of the model properties are themselves objects or arrays of objects.
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Adding the Reaction for Transcription

A simple model of transcription shows only the DNA and mRNA. For more
details, see “Transcription” on page 2-3.

1 Enter the reaction DNA -> DNA + mRNA with reaction rate equation
v=K*DNA.

Robj1
Kobj1

addreaction(Mobj, 'DNA -> DNA + mRNA');
addkineticlaw(Robj1, 'MassAction');

The property KineticLawName is set to 'MassAction'. Because the
reaction is enough information to determine the rate equation, the property
Expression is set to 'MassAction' and the abstract kinetic law expression
is assumed to be 'k*DNA'.

2 Define the reaction rate constant k1=0.2. For a first- order reaction, the
property ParameterVariableNames has a single rate constant that needs
defining. First create a parameter object named k1, and then use the
parameter object name to set the rate constant in ParametervVariableNames
to that object.

Pobj1 = addparameter(Kobj1, 'ki1', 0.2);
set(Kobj1, 'ParameterVariableNames', 'k1');

3 Enter the initial amount for the species DNA=50 and mRNA=0.

s = shioselect(Mobj, 'Type', 'species', 'Name', 'DNA');
s.InitialAmount = 50;

The value for mRNA defaults to 0.
4 Check the initial amounts for the species.
Mobj.Species
MATLAB displays a summary list.

Species Object Array

Index: Name: InitialAmount: InitialAmountUnits:
1 DNA 50
2 mRNA 0
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Adding the Reaction for Translation

A simple model of translation shows only the mRNA and protein product. For
more details, see “Translation” on page 2-4.

1 Enter the reaction mRNA -> mRNA + protein with reaction rate equation
v = k*mRNA.

Robj2 addreaction(Mobj, 'mRNA -> mRNA + protein');
Kobj2 = addkineticlaw(Robj2, 'MassAction');

2 Define the reaction rate constant K2 = 20 1/second.

Pobj2 = addparameter(Kobj2, 'k2', 20.0);
set(Kobj2, 'ParameterVariableNames','K2');

Adding the Reactions for Gene Regulation

Transcription of DNA to mRNA is regulated by the binding of the protein
product from translation to the DNA. As more protein is produced, the DNA is
bound with the protein more often and less time is available for transcription
with the unbound DNA. For more details, see “Gene Repression” on page 2-4.

1 Enter the forward reaction for DNA + protein -> DNA protein with a

forward reaction rate equation v = K3*DNA*protein and a reverse rate v
= K3r*DNA:protein.

Robj3 addreaction(Mobj, 'DNA + protein -> DNA protein');
Kobj3 addkineticlaw(Robj3, 'MassAction');

Pobj3 = addparameter(Kobj3, 'k3', 0.2);

set(Kobj3, 'ParameterVariableNames', 'k3');

2 Enter the reverse reaction.

Robj3r addreaction(Mobj, 'DNA_protein -> DNA + protein');
Kobj3r = addkineticlaw(Robj3r, 'MassAction');

Pobj3r addparameter(Kobj3r, 'k3r', 1.0);

set(Kobj3r, 'ParameterVariableNames', 'k3r');
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Adding the Reactions for mRNA and Protein
Degradation

Protein and mRNA degradation are important reactions for regulating
gene expression. The steady-state level of the compounds is maintained
by a balance between synthesis and degradation reactions. Proteins are
hydrolyzed to amino acids with the help of proteases, while nucleic acids
are degraded to nucleotides.

1 Enter the reaction for mRNA degradation to nucleotides.

Robj5 addreaction(Mobj, 'mRNA -> null');
Kobj5 addkineticlaw(Robj5, 'MassAction');
Pobj5 = addparameter(Kobj5, 'k5', 1.5);

set(Kobj5, 'ParameterVariableNames','k5');

2 Enter the reaction for protein degradation to amino acids.

Robj6 = addreaction(Mobj, 'protein -> null');
Kobj6 = addkineticlaw(Robj6, 'MassAction');
Pobj6 = addparameter(Kobj6, 'k6', 1.0);
set(Kobj6, 'ParameterVariableNames','k6');

Simulating the Model with an ODE Solver

After you create the model, enter reactions, and set parameters, you can
simulate the dynamic behavior of a model.

1 Get a listing of the configuration set attached to the model.

cs = getconfigset(Mobj)

The configuration set object defines the parameters needed for a simulation.

MATLAB displays a listing of the configuration set property values.

Configuration Settings - default (active)

SolverType: ode15s

StopTime: 10.000000
SolverOptions:

AbsoluteTolerance: 1.000000e-006
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RelativeTolerance: 1.000000e-003

SensitivityAnalysis: false
RuntimeOptions:

StatesTolLog: 4
CompileOptions:

UnitConversion: false

DimensionalAnalysis: true

SensitivityAnalysisOptions:
ParameterInputFactors: 0
SpeciesInputFactors: 0

2 Set the final simulation time.

set(cs, 'StopTime', 8.0);

3 Run the simulation.

[t_ode, x_ode] = sbiosimulate(Mobj, cs);

4 Plot the results.

figure(1);

set(gcf, ‘color', 'white');

plot(t_ode, x_ode(:,1:4));

title('Gene Regulation - ODE15s Solver');
xlabel('Time (seconds)');

ylabel('Species Amounts');

axis([0, 8, 0, 50]);

MATLAB draws a figure with the simulation results.
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Simulating the Model with a Stochastic Solver

SimBiology includes three stochastic solvers. The stochastic solvers more
accurately calculate the change in species amounts with a small number
of molecules.

1 Get the active configuration set for a model.
cs = getconfigset(Mobj);
2 Select the stochastic solver and list the configuration set properties.

cs = getconfigset(Mobj);
set(cs, 'SolverType', 'ssa');
cs

MATLAB displays properties for the current configuration set. Notice that
the SolverOptions for the stochastic solver are different from the ODE
options.

Configuration Settings - default (active)
SolverType: ssa
StopTime: 10.000000



Modeling Using the Command-line Interface

SolverOptions:
AbsoluteTolerance: 1.000000e-006
RelativeTolerance: 1.000000e-003
SensitivityAnalysis: false
RuntimeOptions:
StatesTolLog: 4
CompileOptions:
UnitConversion: false
DimensionalAnalysis: true

SensitivityAnalysisOptions:
ParameterInputFactors: 0
SpeciesInputFactors: 0

3 Change the values for the StopTime and LogDecimation properties.

cs.SolverOptions.LogDecimation = 10
cs.StopTime = 10;

4 Run the simulation.

[t_ssa, x_ssa] = sbiosimulate(Mobj, cs);

5 Plot the results.

figure(2);

set(gcf, ‘color', 'white');
plot(t_ssa,x_ssa(:,1:4));

title('Gene Regulation with SSA Solver');
xlabel('Time (second)');

ylabel('Amount (molecule)');

set(gcf, '‘color', 'white');

axis([0, 10, 0, 50]);

MATLAB draws a figure with the results from the simulation. Add labels
by selecting Text Arrow from the Insert menu.
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